Evaluating the AD7944/AD7985/AD7986 14-/16-/18-Bit, PulSAR ADCs

FEATURES
Full featured evaluation board for the AD7944/AD7985/AD7986
Versatile analog signal conditioning circuitry
On-board reference, reference buffers, and ADC drivers
System demonstration board compatible (EVAL-SDP-CH1Z)
PC software for control and data analysis of time and frequency domain

EVALUATION KIT CONTENTS
EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation board

ADDITIONAL EQUIPMENT AND SOFTWARE
System demonstration platform (EVAL-SDP-CH1Z)
Precision source
World-compatible, 12 V dc supply adapter
(included with EVAL-SDP-CH1Z)
Power supply, +7.5 V/−3.0 V (optional)
USB cable
SMA cable

ONLINE RESOURCES
Documents Needed
AD7944, AD7985, and AD7986 data sheet
EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ user guide

Required Software
AD7944/AD7985/AD7986 evaluation software
Design and Integration Files
Schematics, layout files, bill of materials

GENERAL DESCRIPTION
The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ are evaluation boards designed to demonstrate the low power performance of the AD7944/AD7985/AD7986 14-/16-/18-bit, PulSAR® analog-to-digital converters (ADCs) and to provide an easy to understand interface for a variety of system applications. Full descriptions of the AD7944, AD7985, and AD7986 are available in the respective product data sheets, which should be consulted in conjunction with this user guide when using these evaluation boards.

The user PC software controls the evaluation board over the USB cable through the Analog Devices, Inc., system demonstration platform (SDP) board, the EVAL-SDP-CH1Z.

On-board components include the following:
- The ADR3412/ADR4525/ADR4550 high precision, buffered band gap, 1.2 V/2.048 V/5.0 V reference options
- The AD8031 reference buffer
- The ADA4899-1/ADA4897-1/AD8021 signal conditioning circuit with three op amps and an option to use a differential amplifier (AD8139)
- The ADP7118, ADM7160, ADP2370, and ADP7182 regulators to derive necessary voltage levels on board

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards interface to the EVAL-SDP-CH1Z SDP board via a 160-pin FMC connector. SMA connectors, JP1/JP4 and JP2/JP5, are provided for the low noise analog signal source.

TYPICAL EVALUATION SETUP

![TYPICAL EVALUATION SETUP](image-url)

Figure 1.
TABLE OF CONTENTS

Features ................................................................. 1
Evaluation Kit Contents ........................................... 1
Additional Equipment and Software ....................... 1
Online Resources ...................................................... 1
General Description ............................................... 1
Typical Evaluation Setup ........................................... 1
Revision History ...................................................... 2
Functional Block Diagram ......................................... 3
Evaluation Board Hardware ....................................... 4
  Device Description ............................................... 4
  Hardware Link Options .......................................... 4
  Power Supplies .................................................... 4
  Serial Interface .................................................... 6
  Analog Inputs ...................................................... 6
  Reference Options ............................................... 6
  Layout Guidelines ............................................... 7

Basic Hardware Setup ............................................. 7
Evaluation Board Software ...................................... 8
  Software Installation ........................................... 8
  Launching the Software ....................................... 10
  Software Operation ............................................ 11
  WaveForm Capture .............................................. 13
  DC Testing—Histogram ........................................ 14
  AC Testing—Histogram ........................................ 14
  AC Testing—FFT Capture ..................................... 15
  Summary Tab ....................................................... 16

Troubleshooting .................................................... 17
  Software ........................................................... 17
  Hardware .......................................................... 17

Evaluation Board Schematics and Artwork ................. 18
  Bill of Materials ................................................ 25

REVISION HISTORY

7/15—Revision 0: Initial Version
Figure 2.
EVALUATION BOARD HARDWARE

DEVICE DESCRIPTION

The AD7944 is a 14-bit, 2.5 MSPS successive approximation (SAR) ADC. The AD7985 is a 16-bit, 2.5 MSPS SAR ADC. The AD7986 is an 18-bit, 2 MSPS SAR ADC.

These ADCs are low power and high speed and include an internal conversion clock, an internal reference (and buffer), error correction circuits, and a versatile serial interface port. On the rising edge of CNV, each ADC samples an analog input, IN+, between 0 V and REF with respect to the ground sense, IN−. The ADCs feature a very high sampling rate turbo mode (TURBO is high) and a reduced power normal mode (TURBO is low) for low power applications where the power is scaled with the throughput.

Full descriptions of the AD7944, AD7985, and AD7986 are available in the respective product data sheets, which should be consulted in conjunction with this user guide when using the evaluation boards. Full details on the EVAL-SDP-CH1Z are available at the SDP board product page.

HARDWARE LINK OPTIONS

The default link settings and the functions of the link options are shown in Table 1.

Table 1. Pin Jumper Descriptions

<table>
<thead>
<tr>
<th>Link</th>
<th>Default</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1, JP2</td>
<td>B to center</td>
<td>Connects analog inputs VIN+ and VIN− to the inputs of the ADC driver ADA4899-1, ADA4897-1, or AD8021. The A to center position sets the fully differential path through the AD8139.</td>
</tr>
<tr>
<td>JP3, JP4</td>
<td>B to center</td>
<td>Connects the outputs from the ADA4899-1 to the inputs of the ADC. The A to center position sets the fully differential path.</td>
</tr>
<tr>
<td>JP5</td>
<td>A to center</td>
<td>Connects the VCM output from the ADR4550 to the VCM buffer AD8031.</td>
</tr>
<tr>
<td>JP6</td>
<td>B to center</td>
<td>Connects 2.5 V to the ADC AVDD (analog core) supply. To prevent permanent damage to the ADC, do not connect this supply to supplies &gt;2.5 V.</td>
</tr>
<tr>
<td>JP7</td>
<td>ADC specific</td>
<td>Single or differential ADC input selection. The AD7986 default position is B to center. The AD7944 and AD7985 default position is A to center.</td>
</tr>
<tr>
<td>JP8</td>
<td>B to center</td>
<td>Connects 7.5 V to amplifier +Vs.</td>
</tr>
<tr>
<td>JP9</td>
<td>B to center</td>
<td>Connects −3.0 V to amplifier −Vs.</td>
</tr>
<tr>
<td>JP10</td>
<td>B to center</td>
<td>Connects 5 V to ADC BVDD. For an external reference, the best performance is obtained when the reference source that is connected to the REF pins and BVDD are the same. Used in conjunction with LK3.</td>
</tr>
<tr>
<td>JP11</td>
<td>B to center</td>
<td>Connects 2.5 V to ADC DVDD (digital core) supply. To prevent permanent damage to the ADC, do not connect this supply to supplies &gt;2.5 V.</td>
</tr>
<tr>
<td>JP12</td>
<td>B to center</td>
<td>Connects 2.5 V to the ADC digital input/output supply.</td>
</tr>
<tr>
<td>LK1</td>
<td>B</td>
<td>Option to use external 12 V power supply or +12V_FMC power from the EVAL-SDP-CH1Z.</td>
</tr>
<tr>
<td>LK2</td>
<td>REFIN to GND</td>
<td>Selects the internal reference and/or the reference buffer. Used in conjunction with LK10 and LK3.</td>
</tr>
<tr>
<td>LK3</td>
<td>Not inserted</td>
<td>Option to connect REF with BVDD.</td>
</tr>
<tr>
<td>LK4</td>
<td>B</td>
<td>Connects to the 7.5 V supply coming from the ADP7118.</td>
</tr>
<tr>
<td>LK5</td>
<td>B</td>
<td>Connects to the −3.0 V supply coming from the ADP2370.</td>
</tr>
<tr>
<td>LK6</td>
<td>B</td>
<td>Connects the VCM to VCM buffer AD8031.</td>
</tr>
<tr>
<td>LK7</td>
<td>A</td>
<td>Connects the +5 V output from the ADR4550 to generate the REF buffer AD8031.</td>
</tr>
<tr>
<td>LK8</td>
<td>A to B</td>
<td>Connects the SDO pin of the ADC to the level shifter pin.</td>
</tr>
<tr>
<td>LK9, LK11, LK12, LK13</td>
<td>B to center</td>
<td>Connect the TURBO, SDI, CNV, and SCK pins of the ADC to level shifter pins. The A to center position bypasses the level shifter. To prevent different voltage level damage to the ADC, the B to center position is recommended.</td>
</tr>
<tr>
<td>LK10</td>
<td>A</td>
<td>Selection of either the internal reference of the ADC or an external reference.</td>
</tr>
<tr>
<td>LK16</td>
<td>B</td>
<td>Connects −NEG with the −3.0 V supply coming from the ADP2370. The A to center position connects with ADP7182.</td>
</tr>
</tbody>
</table>

POWER SUPPLIES

The power (12 V) for the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards comes through a 160-pin FMC connector, J7, from the EVAL-SDP-CH1Z. The user also has the option of using an external 12 V supply to power the evaluation board. On-board regulators generate the required levels from the applied 12 V rail. The ADP7118 (U18) supplies 7.5 V for the +Vs pin of the ADC driver amplifiers (ADA4899-1, ADA4897-1, or AD8021), the external reference ADR4550 (U5), the ADR4525 (U8), and the ADR3412. Another ADP7118 (U10) supplies 5 V for BVDD (U1), the ADP2370 (U2), and the ADM7160 (U3 and U12). The ADP2370 (U2), in turn, directly generates −3.0 V or connects to the ADP7182 to generate −2.5 V for the −Vs pin of the amplifier. The ADM7160 (U3 and U12) provides 2.5 V for DVDD and VIO (U1). The user also can use external bench top supplies to power the on-board amplifiers. The 3.3 V supply for the EEPROM (U7) comes from the EVAL-SDP-CH1Z through a 160-pin FMC connector, J7. Each supply is decoupled where it enters the board and again at each device. A single ground plane is used on this board to minimize the effect of high frequency noise interference.
Table 2. On-Board Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1, J2, J4, J5</td>
<td>SMA analog input. Connects the low noise analog signal source to the inputs of the ADC driver ADA4899-1, ADA4897-1, AD8021, or AD8139.</td>
</tr>
<tr>
<td>J3</td>
<td>3-pin terminal. This option is for using external bench top supplies. Apply external +Vs, −Vs, and GND to power amplifiers on the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation board.</td>
</tr>
<tr>
<td>J6</td>
<td>6-pin (2 × 3) socket. This option is for interfacing with an external ADC driver board.</td>
</tr>
<tr>
<td>J7</td>
<td>160-pin FMC 10 mm male VITA 57 connector. This connector mates with the EVAL-SDP-CH1Z board.</td>
</tr>
<tr>
<td>J8, J9</td>
<td>7-pin (1 × 7) header connector. This option is for using an external ADC driver board.</td>
</tr>
<tr>
<td>J10</td>
<td>6-pin (1 × 6) header connector. This option is for using an external serial interface to control the ADC.</td>
</tr>
</tbody>
</table>

Table 3. On-Board Power Supplies Description

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>Voltage Range (V)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>+Vs</td>
<td>+5 to +7.5</td>
<td>The two ADP7118 devices (U10, U18) generate the necessary 5 V and 7.5 V supplies, respectively, from the 12 V supply coming from the EVAL-SDP-CH1Z, or from external power supply. The 7.5 V supply is recommended for the on-board amplifier +Vs. The 5 V supply is provided to AVDD (U1), the ADP2370 (U2), the ADR4525/ADR4550/ADR3412 (U5, U8, and U13), and the ADM7160 (U3 and U12). The user also has the option to use an external bench top supply for +Vs through J3.</td>
</tr>
<tr>
<td>−Vs</td>
<td>−2 to −5</td>
<td>The ADP2370 generates −3.0 V or connects to the ADP7182 to generate −2.5 V for the −Vs pin of the amplifier. The user also has the option to use an external bench top supply for −Vs through J3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximum range of supply for correct operation.</td>
</tr>
<tr>
<td>AVDD</td>
<td>5</td>
<td>Analog supply rail (U1).</td>
</tr>
<tr>
<td>DVDD, VIO</td>
<td>2.5</td>
<td>ADC supply rails.</td>
</tr>
</tbody>
</table>

1 Dictated by ADA4899-1 supply operation.
2 Refer to the AD7944, AD7985, and AD7986 data sheets.
SERIAL INTERFACE

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards use the serial interface connection to the EVAL-SDP-CH1Z. The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ have two different data reading options: read during conversion and read during acquisition, both of which can operate in 3-wire and 4-wire serial interface modes. When using the serial interface, the voltage level shifter option and the external compatible serial interface options are supported. The serial interface requires five pins (SDI, SCK, SDO, TURBO, and CNV) connected between each ADC and the digital host.

The EVAL-SDP-CH1Z board features include the following:

- XILINX Spartan®-6 FPGA
- DDR2
  - Micron MT47H32M16Hr-25E:G
    8 Mb x 16 bits x 4 Banks(512 Mb/64 Mb)
- SRAM
  - ISSI IS61WV25616BLL-10BLI
    256 kB x 16 bits (4 Mb/512 kB)
- 1 x 160-pin FMC-LPC connector (refer to the VITA 57 specification)
  - Samtec ASP-134603-01
  - Up to 1080 Mbps LVDS
  - Single-ended LVCMOS
  - Power
- Analog Devices ADSP-BF527 Blackfin® processor
  - Core performance up to 600 MHz
  - 208-ball CSP-BGA package
  - 24 MHz CLKIN oscillator
- 32 Mb flash memory
  - Numonyx M29W320EB or Numonyx M25P32
- SDRAM memory
  - Micron MT48LC16M16A2P-6A
    16 Mb x 16 bits (256 Mb/32 MB)
- 2 x 120-pin small foot print connectors
  - Hirose FX8-120P-SV1(91), 120-pin header
- Blackfin processor peripherals exposed
  - SPI
  - SPORT
  - TWI/FIC
  - GPIO
  - PPI
  - Asynchronous parallel

ANALOG INPUTS

The analog inputs applied to the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards are the J1 and J2 SMA (push on) connectors. These inputs are buffered with dedicated, discrete driver amplifier circuitry (U15 and U16 or U14), as shown in Figure 1.

The circuit allows different configurations, input range scaling, filtering, the addition of a dc component, the use of a different op amp, and a differential amplifier and supplies. The analog input amplifiers are set as unity-gain buffers at the factory. The positive rails of the driver amplifiers (U14, U15, and U16) are driven from 7.5 V (from the ADP7118, U18), and the negative rails are driven from ~3.0 V. The positive rails of the other reference buffers (U4 and U11) are driven from 7.5 V, and the negative rails are grounded; these rails can be changed as required. The range of possible supplies is listed in Table 3. The default configuration sets both U15 and U16 at midscale generated from a buffered reference voltage (VCM) of the ADR4550 (U5).

The evaluation board is factory configured to provide either a single-ended path or a fully differential path, as described in Table 1. Because the AD7986 is differential, both inputs and amplifier circuits are used to buffer the IN+ and IN− inputs of the ADCs. For the AD7944 and the AD7985 evaluation boards, only the J2, U15, and associated circuitry are used in the path.

For dynamic performance, an FFT test can be performed by applying a very low distortion source. For low frequency testing, use the audio precision source. Set the outputs for balanced and floating. Different sources can be used, though most are single-ended and use a fixed output resistance.

Because the evaluation board uses the amplifiers in unity gain, the noninverting input has a common-mode input with a series 590 Ω resistor, which must be taken into account when directly connecting a source (voltage divider).

REFERENCE OPTIONS

The AD7944, AD7985, and AD7986 each have an internal 4.096 V reference together with an internal buffer that can be used with an external reference; the devices can also use an external 5.0 V or 2.048 V reference directly. The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards can be configured to use any of these references. The jumpers and linkers used to set the reference are shown in Table 1.

External Reference: Default Configuration

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards include an external 5 V and 2.048 V reference. This reference can drive the ADCs and the REF pin directly, or it can be buffered with the AD8031; the factory default setting is 5 V and buffered with the AD8031. The best attainable signal-to-noise ratio (SNR) is achieved by using the maximum reference voltage of 5 V. Refer to the AD7944, AD7985, and AD7986 data sheets for more details.
Internal 4.096 V Reference

The AD7944/AD7985/AD7986 ADCs have an internal 4.096 V precision reference that can be used on most applications. Connecting PDREF to GND enables the internal reference. When the internal reference is enabled, a 4.096 V as well as a 1.2 V band gap are present on the ADC REF pin and test point. When using this method, R14 and R17 must be removed to achieve the best performance. External sources must not be connected to these test points because they are directly connected to the ADC pins.

Internal Reference Buffer

The internal reference buffer is useful when using an external 1.2 V reference. When using the internal reference buffer, applying 1.2 V reference ADR3412 (U13) to REFIN, which is directly connected to the REFIN pin of the ADC, produces 4.096 V at the REF pin of the ADC. R14 and R17 must be removed to achieve the best performance. External sources must not be connected to these test points because they are directly connected to the ADC pins.

LAYOUT GUIDELINES

When laying out the printed circuit board (PCB) for the ADC, follow these recommended guidelines to obtain the maximum performance from the converter.

- Solder the ADC exposed paddle (Pin 21) directly to the PCB, and connect the paddle to the ground plane of the board using multiple vias.
- Decouple all the power supply pins (AVDD, BVDD, and VIO) and the REF pin with low ESR and low ESL ceramic capacitors, typically 10 μF and 100 nF, placed close to the DUT (U1) and connected using short, wide traces. This provides low impedance paths and reduces the effect of glitches on the power supply lines.
- The ADC voltage reference inputs (REF) have a dynamic input impedance and must be decoupled with minimal parasitic inductances, by placing the reference decoupling ceramic capacitor close to, ideally right up against, the REF and REFGND pins and connecting them with wide, low impedance traces.
- Separate analog and digital sections and keep power supply circuitry away from the ADC.
- Avoid running digital lines under the device as well as crossover of digital and analog signals, because these couple noise into the ADC.
- Do not run fast switching signals, such as CNV or clocks, near analog signal paths.
- Remove the ground and power plane beneath the input (including feedback) and output pins of the amplifiers (U14, U15, and U16), because they create an undesired capacitor.

BASIC HARDWARE SETUP

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards connect to the (EVAL-SDP-CH1Z) system demonstration board. The EVAL-SDP-CH1Z board is the controller board, which is the communication link between the PC and the main evaluation board.

Figure 1 shows a photograph of the connections between the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ daughter board and the EVAL-SDP-CH1Z controller board.

1. Install the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ software. Ensure that the EVAL-SDP-CH1Z board is disconnected from the USB port of the PC while installing the software. The PC must be restarted after the installation.
2. Before connecting power, connect the 160-pin FMC connector, J7, of the evaluation board to the J4 connector on the EVAL-SDP-CH1Z board. Nylon screws are included in the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation kit and can be used to ensure that the evaluation board and the EVAL-SDP-CH1Z board are connected firmly together.
3. Connect the 12 V power supply adapter included in the kit to the EVAL-SDP-CH1Z.
4. Connect the EVAL-SDP-CH1Z board to the PC via the USB cable. Windows XP users may need to search for the EVAL-SDP-CH1Z drivers. Choose to automatically search for the drivers for the EVAL-SDP-CH1Z board if prompted by the operating system.
5. Launch the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ software from the Analog Devices subfolder in the Programs menu. The full software installation procedure is described in the Evaluation Board Software section.
EVALUATION BOARD SOFTWARE
SOFTWARE INSTALLATION

The AD7944/AD7985/AD7986 evaluation software is available to download from the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ product pages. Double-click the setup.exe file to run the install. The default location for the software is C:\Program Files (x86)\Analog Devices\AD7944_85_86 Evaluation Software.

Install the evaluation software before connecting the evaluation board and EVAL-SDP-CH1Z board to the USB port of the PC to ensure that the evaluation system is correctly recognized when connected to the PC.

There are two parts of the software installation process:

- AD7944/AD7985/AD7986 evaluation software installation
- EVAL-SDP-CH1Z board driver installation

Figure 3 to Figure 9 show the separate steps to install the AD7944/AD7985/AD7986 evaluation software, and Figure 10 to Figure 15 show the separate steps to install the EVAL-SDP-CH1Z drivers. Proceed through all of the installation steps to install the software and drivers in the appropriate locations.

Connect the EVAL-SDP-CH1Z board to the PC only after the software and drivers have been installed.
After installation is complete, connect the EVAL-AD7944FMCZ, the EVAL-AD7985FMCZ, or the EVAL-AD7986FMCZ to the EVAL-SDP-CH1Z board, as described in the Evaluation Board Hardware section.

When you first plug in the EVAL-SDP-CH1Z board via the USB cable provided, allow the new Found Hardware Wizard to run. Once the drivers are installed, check that the board has connected correctly by looking at the Device Manager of the PC. The Device Manager can be accessed via My Computer > Manage > Device Manager from the list of System Tools. The EVAL-SDP-CH1Z board appears under ADI Development Tools, which indicates that the installation is complete.

LAUNCHING THE SOFTWARE

Once the evaluation board and the EVAL-SDP-CH1Z board are correctly connected to your PC, the AD7944/AD7985/AD7986 evaluation software can be launched.

1. From the Start menu, click Programs > Analog Devices > AD7944_85_86 Evaluation Software. The main window of the software appears (see Figure 19).
   a. If the evaluation system is not connected to the USB port via the EVAL-SDP-CH1Z when the software is launched, a connectivity error displays (see Figure 17).
   b. Connect the evaluation board to the USB port of the PC.
   c. Wait for a few seconds and then click Rescan (see Figure 18).
SOFTWARE OPERATION

This section describes the full software operation and all the windows that appear. When the software is launched, the main software window opens, and the software searches for hardware connected to the PC. The user software window launches as shown in Figure 19. The labels listed in this section correspond to the numbered labels in Figure 19.

File Menu

The File menu, Label 1 in Figure 19, has the following options:

- **Save Captured Data**: saves data to a .CSV file
- **Load Captured Data**: loads data for analysis
- **Take Screenshot**: saves the current screen
- **Print**: prints the window to the default printer
- **Exit**: closes the application

Edit Menu

The Edit menu, Label 2 in Figure 19, provides the Initialize to Default Values option, which resets the software to its initial state.

Help Menu

The Help menu, Label 3 in Figure 19, offers help from the

- Analog Devices website
- User Guide
- Context Help
- About

Eval Board Connected

This indicator, Label 4 in Figure 19, shows that the evaluation board is connected. In Figure 19, the connected evaluation board is the EVAL-AD7985FMCZ.

Samples

From the Samples drop-down menu, Label 5 in Figure 19, select the number of samples to analyze when running the software; this number is limited to 1,048,576 samples.

Single Capture and Continuous Capture

Clicking Single Capture, Label 6 in Figure 19, performs a single capture, whereas clicking Continuous Capture, Label 7 in Figure 19, performs a continuous capture from the ADC.

Interface Selection

The Interface Selection drop-down menu, Label 8 in Figure 19, provides options for using 3-wire or 4-wire mode, reading during or reading after conversion, and no busy signal mode.

Voltage Reference

The options for using the external reference or internal reference are controlled by the Voltage Reference drop-down menu, Label 9 in Figure 19. The default value is set to 5 V (external reference and external buffer). The other voltage reference options are 4.096 V (external or internal reference) and 2.048 V (external reference). When using the external reference, it is recommended to use an on-board AD8031 as an external reference buffer.

Turbo Mode

The Turbo Mode button, Label 10 in Figure 19, provides the options of Turbo On or Turbo Off (normal mode). Note that the throughput must be manually changed when changing modes.

Throughput

The Through Output field, Label 11 in Figure 19, controls the throughput. The default throughput (sampling frequency) is 2000 kSPS. The user can adjust the sampling frequency; however there are limitations around the sample frequency related to the SCLK frequency applied. The sample frequency must be at least 200 kSPS. The AD7985 is capable of operating a maximum sample frequency of 2500 kSPS in reading during conversion turbo mode.

If the user enters a value exceeding the maximum capacity of the device, the software indicates this, and the user must revert to the maximum sample frequency.

Tabs

There are four additional tabs available for displaying the data in different formats.

- Waveform
- Histogram
- FFT
- Summary

To exit the software, go to File > Exit.
Figure 19. Evaluation Software Window
WAVEFORM CAPTURE

Figure 20 shows the Waveform tab. A 20 kHz sine wave input signal was used along with an on-board 5 V external reference. The Waveform Analysis boxes, Label 1 in Figure 20, show the amplitudes recorded from the captured signal in addition to the frequency of the signal tone.

![Figure 20. Waveform Capture Tab](image)
DC TESTING—HISTOGRAM

Figure 21 shows the Histogram tab. The histogram can be used to test the ADC for the code distribution for dc input, compute the mean and standard deviation or transition noise of the converter, and display the results. Raw data is captured and passed to the PC for statistical computations.

To perform a histogram test, click the Histogram tab, then click Single Capture or Continuous Capture.

A histogram test can be performed without an external source because the evaluation board has a buffered \( V_{\text{REF}}/2 \) source at the ADC input.

To test other dc values, apply a source to the J1 and J2 inputs. The signal may need to be filtered so that the dc source noise is compatible with that of the ADC.

AC TESTING—HISTOGRAM

The histogram can also be used to test the ADC for the code distribution for ac input, compute the mean and standard deviation or transition noise of the converter, and display the results. Raw data is captured and passed to the PC for statistical computations.

To perform a histogram test, click the Histogram tab, then click Single Capture or Continuous Capture.

An ac histogram requires a quality signal source applied to the input J1/J2 connectors.

Figure 21 shows the histogram for a 20 kHz sine wave applied to the ADC input and the results calculated.

The Histogram Analysis boxes, Label 1 in Figure 21, show the various measured values for the data captured.

![Figure 21. Histogram Capture Tab](image-url)
AC TESTING—FFT CAPTURE

Figure 22 shows the FFT tab. This tests the traditional ac characteristics of the converter and displays a fast Fourier transform (FFT) of the results. As in the histogram test, raw data is captured and passed to the PC where the FFT is performed to display the signal-to-noise ratio (SNR), signal-to-noise-and-distortion ratio (SINAD), total harmonic distortion (THD), and spurious-free dynamic range (SFDR).

To perform an ac test, apply a sinusoidal signal to the evaluation board at the SMA inputs, J1 and J2. A very low distortion, better than 130 dB input signal source (such as audio precision) is required to allow true evaluation of the device. One possibility is to filter the input signal from the ac source. There is no suggested band-pass filter, but carefully consider the choices. Furthermore, if using a low frequency band-pass filter when the full-scale input range is more than a few volts peak-to-peak, it is recommended to use the on-board amplifiers to amplify the signal, thus preventing the filter from distorting the input signal.

Figure 22 displays the results of the captured data.

FFT Analysis shows the input signal information (Label 1), as well as the performance data, including SNR, dynamic range, THD, SINAD, and noise performance (Label 3).

Show Harmonic Content displays the fundamental frequency and amplitude in addition to the second to fifth harmonics (Label 2).
SUMMARY TAB

Figure 23 shows the **Summary** tab, which captures all the display information and provides it in one tab with a synopsis of the information, including key performance parameters such as SNR and THD.
TROUBLESHOOTING
This section provides recommendations on how to prevent and troubleshoot problems encountered with the software and the hardware.

SOFTWARE
Follow these recommendations for the evaluation software:

- Always install the software prior to connecting the hardware to the PC.
- Always allow the install to fully complete (the software installation is a two part process: installing the ADC software and the SDP drivers). This may require a restart of the PC.
- When you first plug in the EVAL-SDP-CH1Z board via the USB cable provided, allow the new Found Hardware Wizard to run. Though this may take time, do this prior to starting the software.
- If the board does not appear to be functioning, ensure that the ADC evaluation board is connected to the EVAL-SDP-CH1Z board and that the SDP board is recognized in the Device Manager, as shown in Figure 16.
- If connected to a slower USB port where the EVAL-SDP-CH1Z cannot read quickly, a timeout error may occur. In this case, it is advised not to read continuously or, alternatively, to lower the number of samples taken.
- Note that when reading continuously from the ADC, the recommended number of samples is up to 1,048,576.

HARDWARE
If the software does not read any data back, take the following steps:

- With the 12 V wall wart plugged in to the EVAL-SDP-CH1Z board, check that the voltage applied is within the ranges shown in Table 3.
- Using a digital multimeter (DMM), measure the voltage present at 12 V and the VADJ test points, which should read 12 V and 2.5 V, respectively. The +12V_FMC LED of the evaluation board and the LEDs of the EVAL-SDP-CH1Z board (FMC_PWR_GO, SYS_PWR, FPGA_DONE, BF_POWER, LED0, and LED2) should all be lit.
- Launch the software and read the data. If nothing happens, exit the software.
- Remove the 12 V wall wart and USB from the EVAL-SDP-CH1Z board, and then reconnect them and relaunch the software.
- If an error occurs, check that the evaluation board and the EVAL-SDP-CH1Z board are connected together so that the EVAL-SDP-CH1Z is recognized in the Device Manager, as shown in Figure 16.

Note that when working with the software in standalone/offline mode (no hardware connected), if you later choose to connect hardware, first close and then relaunch the software.
**EVALUATION BOARD SCHEMATICS AND ARTWORK**

**SYSTEM POWER SUPPLY OPTIONS**

**Figure 24. Schematic—System Power Supply Options**

**OPAMP POWER SUPPLY OPTIONS**

**ADC POWER SUPPLY OPTIONS**

**Figure 25. Schematic—Op Amp and ADC Power Supply Options**
Figure 26. Schematic—External Reference
C73 and C74 are compensation capacitors, guard rings around GREF, see AD8021 Figure 62.

Figure 27. Schematic—Analog Front End
Figure 30. Evaluation Board Silkscreen—Top Assembly

Figure 31. Evaluation Board Silkscreen—Bottom Assembly
Figure 32. Evaluation Board—Top Layer

Figure 33. Evaluation Board Layer 2—Ground
Figure 34. Evaluation Board Layer 3—Power

Figure 35. Evaluation Board Bottom Layer
## BILL OF MATERIALS

Table 4. Analog Bill of Materials for EVAL-AD7986FMCZ

<table>
<thead>
<tr>
<th>Reference Designator</th>
<th>Part Description</th>
<th>Part Number</th>
<th>Stock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>+5V, +7V5, +12V, +12V_EXT, −3P0V, 1PT2V_REFIN, 2PT5V_REF, 2V5_EXT, 3P3VAUX, 5V_REF, BVDD_EXT, GND1 to GND3</td>
<td>Test point</td>
<td>20-313137</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>+12V_SYS</td>
<td>Test point</td>
<td>20-313137</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>LED, 0603, green</td>
<td>Capacitor</td>
<td>SML-LX0603SUGW-TR</td>
<td>Digikey 67-1693-1-ND</td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>MCCAA000255</td>
<td>FEC 1759122</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>GRM188R60J475KE19D</td>
<td>FEC 1735527</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>GRM188R61A105KA61D</td>
<td>FEC 1828798</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>TBA</td>
<td>Do Not Place</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>EMK212B7475KG-T</td>
<td>FEC 2112841</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>EMK212B7225KG-T</td>
<td>FEC 1683654</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>MCCAA000201</td>
<td>FEC 1907308</td>
<td></td>
</tr>
<tr>
<td>Capacitor, 0603</td>
<td>1C608C0G1H101J080AA</td>
<td>FEC 1907297</td>
<td></td>
</tr>
<tr>
<td>Diode, Schottky, 40 V, 0.2 A, 1PS79SB30</td>
<td>SMA</td>
<td>1PS79SB30</td>
<td>FEC 8734097</td>
</tr>
<tr>
<td>Connector, Power 3</td>
<td>CTB5000/3</td>
<td>FEC 151790</td>
<td></td>
</tr>
<tr>
<td>Connector, Power 3</td>
<td>142-0701-851</td>
<td>Digikey J658-ND</td>
<td></td>
</tr>
<tr>
<td>Connector, Power 3</td>
<td>TBA</td>
<td>Not Inserted</td>
<td></td>
</tr>
<tr>
<td>Connector, Power 3</td>
<td>ASP-134604-01</td>
<td>Samtec ASP-134604-01</td>
<td></td>
</tr>
<tr>
<td>Connector, 7 position, header</td>
<td>SSW-107-01-T-S</td>
<td>FEC 1803478</td>
<td></td>
</tr>
<tr>
<td>Connector, 7 position, header</td>
<td>TLW-107-05-G-S</td>
<td>FEC 1668499</td>
<td></td>
</tr>
<tr>
<td>Connector, 6 position, header</td>
<td>TLW-106-05-G-S</td>
<td>Not Inserted</td>
<td></td>
</tr>
<tr>
<td>3 W, solder link, 0603</td>
<td>MC 0.063W 0603 OR</td>
<td>FEC 9331662</td>
<td></td>
</tr>
<tr>
<td>Bead, 0805</td>
<td>HZ0805E601R</td>
<td>DigiKey 240-1018-1-ND</td>
<td></td>
</tr>
<tr>
<td>Inductor, 22 µH, LPS4414-223MLB</td>
<td>LPS4414-223MLB</td>
<td>FEC 2287727</td>
<td></td>
</tr>
<tr>
<td>Inductor</td>
<td>LQH32CN1R0M33L</td>
<td>FEC 9522174</td>
<td></td>
</tr>
<tr>
<td>Jumper, 2</td>
<td>M20-9983646 &amp; M7566-05</td>
<td>FEC 1022244 &amp; 150-411 (36 Pin Strip)</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>M20-9990246</td>
<td>Do Not Insert</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>MC0063W060313K3</td>
<td>FEC 9331026</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>MC0063W0603123K7</td>
<td>FEC 1170924</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>MC 0.1W 0805 0R</td>
<td>FEC 9333681</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>MC0063W0603164K9</td>
<td>FEC 1170968</td>
<td></td>
</tr>
<tr>
<td>Resistor</td>
<td>MC 0.063W 0603 1% 1K</td>
<td>FEC 9330380</td>
<td></td>
</tr>
</tbody>
</table>

Rev. 0 | Page 25 of 31
<table>
<thead>
<tr>
<th>Reference Designator</th>
<th>Part Description</th>
<th>Part Number</th>
<th>Stock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>R15, R20, R21, R23, R24, R27 to R29, R31 to R33, R35, R36, R43, R46, R48, R50, R59, R60, R64, R65, R67</td>
<td>Resistor, 0 Ω</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>R18</td>
<td>Resistor</td>
<td>CRCW08055K00FKTA</td>
<td>FEC 1835558</td>
</tr>
<tr>
<td>R19</td>
<td>Resistor</td>
<td>MCTR0525B1002T5E</td>
<td>FEC 1575900</td>
</tr>
<tr>
<td>R25, R30</td>
<td>Resistor</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>R34</td>
<td>Resistor</td>
<td>MC01W08051100R</td>
<td>FEC 9332375</td>
</tr>
<tr>
<td>R37, R38, R40, R41</td>
<td>Resistor</td>
<td>ERA6AE5900V</td>
<td>FEC 1810481</td>
</tr>
<tr>
<td>R42, R51, R54, R56</td>
<td>Resistor</td>
<td>ERA3AB210V</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>R52, R53</td>
<td>Resistor</td>
<td>CPF0805B10RE1</td>
<td>FEC 1697403</td>
</tr>
<tr>
<td>R57, R58</td>
<td>82 Ω, 0603, 1%, 0.063 W</td>
<td>MC0063W0603182R</td>
<td>FEC 9331590</td>
</tr>
<tr>
<td>R61</td>
<td>Resistor</td>
<td>MC0063W060311R0</td>
<td>FEC 2141505</td>
</tr>
<tr>
<td>R62</td>
<td>18 Ω, 0805, 1%, 0.1 W</td>
<td>MC01W0805118R</td>
<td>FEC 9332740</td>
</tr>
<tr>
<td>R66</td>
<td>Resistor</td>
<td>MC0063W0603110K</td>
<td>FEC 9330399</td>
</tr>
<tr>
<td>R68</td>
<td>Resistor</td>
<td>CRCW040200000Z0ED</td>
<td>FEC 1469661</td>
</tr>
<tr>
<td>R69</td>
<td>Resistor</td>
<td>MC00625W0402111K</td>
<td>FEC 1358070</td>
</tr>
<tr>
<td>R71</td>
<td>Resistor</td>
<td>MC00625W0402111K5</td>
<td>FEC 1803142</td>
</tr>
<tr>
<td>U1</td>
<td>AD7986BCPZ</td>
<td>AD7986BCPZ</td>
<td>AD7986BCPZ</td>
</tr>
<tr>
<td>U2</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ-R7</td>
</tr>
<tr>
<td>U3, U12</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5-R2</td>
</tr>
<tr>
<td>U4, U11, U19</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
</tr>
<tr>
<td>U5</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
</tr>
<tr>
<td>U6</td>
<td>FXL2TD245</td>
<td>FXL2TD245L10X</td>
<td>Digikey FXL2TD245L10XCT-ND</td>
</tr>
<tr>
<td>U7</td>
<td>M24C02-WMN6TP</td>
<td>M24C02-WMN6TP</td>
<td>Digikey 497-8552-1-ND</td>
</tr>
<tr>
<td>U8</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
</tr>
<tr>
<td>U9</td>
<td>FXL4TD245BQX</td>
<td>FXL4TD245BQX</td>
<td>Digikey FXL4TD245BQXCT-ND</td>
</tr>
<tr>
<td>U10, U18</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0-R7</td>
</tr>
<tr>
<td>U13</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ-R2</td>
</tr>
<tr>
<td>U14</td>
<td>AD8139ARDZ</td>
<td>AD8139ARDZ</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>U15, U16</td>
<td>ADA4899-1</td>
<td>ADA4899-1YRDZ</td>
<td>ADA4899-1YRDZ</td>
</tr>
<tr>
<td>U17</td>
<td>NC7S04</td>
<td>NC7S04M5</td>
<td>FEC 1013809</td>
</tr>
<tr>
<td>U20</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ-R7</td>
</tr>
<tr>
<td>X1, X2</td>
<td>MTHOLE-4MM</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>Reference Designator</td>
<td>Part Description</td>
<td>Part Number</td>
<td>Stock Code</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>+5V, +7V5, +12V, +12V_EXT, −3P0V, 1PT2V_REFIN, 2PT5V_REF, 2V5_EXT, 3P3VAUX, 5V_REF, BVDD_EXT, GND1 to GND3</td>
<td>Test point</td>
<td>20-313137</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>C1, C8, C11, C15, C25, C32, C33, C38, C39, C42, C44, C60, C62, C65</td>
<td>Capacitor, 0603</td>
<td>MCCA000255</td>
<td>FEC 1759122</td>
</tr>
<tr>
<td>C2, C3, C5, C7, C9, C10, C12, C20, C27, C28, C31, C35, C40, C43, C52, C54 to C56 to C59, C61, C75</td>
<td>Capacitor</td>
<td>GRM188R60J475KE19D</td>
<td>FEC 1735527</td>
</tr>
<tr>
<td>C4, C6, C77, C78</td>
<td>Capacitor</td>
<td>C1608CG1H101J080AA</td>
<td>FEC 1907308</td>
</tr>
<tr>
<td>C6, C19</td>
<td>Capacitor</td>
<td>GRM188R61A105KA61D</td>
<td>FEC 1828798</td>
</tr>
<tr>
<td>C17, C22, C24, C26</td>
<td>Capacitor</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>C13, C16, C18</td>
<td>Capacitor</td>
<td>GRM219R61C106KA73D</td>
<td>FEC 1845747</td>
</tr>
<tr>
<td>C14, C30, C34, C36, C63, C64, C69, C70</td>
<td>Capacitor</td>
<td>EMK212B7475KG-T</td>
<td>FEC 2112841</td>
</tr>
<tr>
<td>C21, C23</td>
<td>Capacitor</td>
<td>EMK212B7225KG-T</td>
<td>FEC 1683654</td>
</tr>
<tr>
<td>C29, C37, C41, C45 to C47, C50, C51, C53, C55, C67, C68, C72 to C74, C79</td>
<td>Capacitor</td>
<td>MCCA000201</td>
<td>FEC 1907308</td>
</tr>
<tr>
<td>C48, C49</td>
<td>Capacitor, 0603</td>
<td>C1608CG1H101J080AA</td>
<td>FEC 1907297</td>
</tr>
<tr>
<td>C71, C76</td>
<td>Diode, Schottky, 40 V, 0.2 A, 1PS795B30</td>
<td>1PS795B30</td>
<td>FEC 8734097</td>
</tr>
<tr>
<td>J1, J2</td>
<td>Connector, Power 3</td>
<td>5-1814400-1</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>J3</td>
<td>SMA</td>
<td>CTB5000/3</td>
<td>FEC 151790</td>
</tr>
<tr>
<td>J4, J5</td>
<td>Connector, 7 position, header</td>
<td>142-0701-851</td>
<td>Digikey 658-ND</td>
</tr>
<tr>
<td>J6</td>
<td>Connector, 6 position, header</td>
<td>142-0701-851</td>
<td>Digikey 658-ND</td>
</tr>
<tr>
<td>J7</td>
<td>Connector, Power 3</td>
<td>5-1814400-1</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>J8</td>
<td>Connector, 7 position, header</td>
<td>142-0701-851</td>
<td>Digikey 658-ND</td>
</tr>
<tr>
<td>J9</td>
<td>Connector, 7 position, header</td>
<td>142-0701-851</td>
<td>Digikey 658-ND</td>
</tr>
<tr>
<td>J10</td>
<td>Connector, 7 position, header</td>
<td>142-0701-851</td>
<td>Digikey 658-ND</td>
</tr>
<tr>
<td>J11</td>
<td>3 W, solder link, 0603</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>L1, L3 to L5</td>
<td>Bead, 0805</td>
<td>HZ0805E601R</td>
<td>DigiKey 240-1018-1-ND</td>
</tr>
<tr>
<td>L2</td>
<td>Inductor, 22 µH, LPS4414-223MLB</td>
<td>LPS4414-223MLB</td>
<td>FEC 2287727</td>
</tr>
<tr>
<td>L6</td>
<td>Inductor, 22 µH, LPS4414-223MLB</td>
<td>LQH32CN1R0M33L</td>
<td>FEC 9522174</td>
</tr>
<tr>
<td>LK1, LK2, LK4, LK5, LK10</td>
<td>Jumper, 2</td>
<td>M20-9983646 &amp; M7566-05</td>
<td>FEG 1022244 &amp; 150-411 (36 Pin Strip)</td>
</tr>
<tr>
<td>R2, R9, R13, R26, R42 to R44, R47, R49 to R51, R54, R55, R56, R70, R72</td>
<td>Resistor</td>
<td>M20-9990246</td>
<td>Do Not Insert</td>
</tr>
<tr>
<td>R5</td>
<td>Resistor</td>
<td>MC0063W060313K3</td>
<td>FEC 9331026</td>
</tr>
<tr>
<td>R6</td>
<td>Resistor</td>
<td>MC0063W0603123K7</td>
<td>FEC 1170924</td>
</tr>
<tr>
<td>R7, R8, R14, R16, R17, R39, R45, R63</td>
<td>Resistor</td>
<td>MC 0.1W 0805 0R</td>
<td>FEC 9333681</td>
</tr>
<tr>
<td>R11</td>
<td>Resistor</td>
<td>MC0063W0603164K9</td>
<td>FEC 1170968</td>
</tr>
<tr>
<td>R12, R22</td>
<td>Resistor</td>
<td>MC 0.063W 0603 1% 1K</td>
<td>FEC 9330380</td>
</tr>
<tr>
<td>Reference Designator</td>
<td>Part Description</td>
<td>Part Number</td>
<td>Stock Code</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>R15, R20, R21, R23, R24, R27 to R29, R31 to R33, R35, R36, R46, R48, R59, R60, R64, R65, R67</td>
<td>Resistor, 0 Ω</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>R18</td>
<td>Resistor</td>
<td>CRCW08055K00FKTA</td>
<td>FEC 1835558</td>
</tr>
<tr>
<td>R19</td>
<td>Resistor</td>
<td>MCTC0525B1002T5E</td>
<td>FEC 1575900</td>
</tr>
<tr>
<td>R25, R30</td>
<td>Resistor</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>R34</td>
<td>Resistor</td>
<td>MC01W08051100R</td>
<td>FEC 9332375</td>
</tr>
<tr>
<td>R37, R38, R40, R41</td>
<td>Resistor</td>
<td>ERA6AEBS900V</td>
<td>FEC 1810481</td>
</tr>
<tr>
<td>R52, R53</td>
<td>Resistor</td>
<td>CPF0805B10RE1</td>
<td>FEC 1697403</td>
</tr>
<tr>
<td>R57, R58</td>
<td>82 Ω, 0603, 1%, 0.063 W</td>
<td>MC0063W0603182R</td>
<td>FEC 9331590</td>
</tr>
<tr>
<td>R61</td>
<td>Resistor</td>
<td>MC0063W060311R0</td>
<td>FEC 2141505</td>
</tr>
<tr>
<td>R62</td>
<td>18 Ω, 0805, 1%, 0.1 W</td>
<td>MC0063W0603110K</td>
<td>FEC 9330399</td>
</tr>
<tr>
<td>R66</td>
<td>Resistor</td>
<td>CRCW04020000Z0ED</td>
<td>FEC 1469661</td>
</tr>
<tr>
<td>R68</td>
<td>Resistor</td>
<td>MC00625W0402111K</td>
<td>FEC 1358070</td>
</tr>
<tr>
<td>R69</td>
<td>Resistor</td>
<td>MC00625W0402111K5</td>
<td>FEC 1803142</td>
</tr>
<tr>
<td>U1</td>
<td>AD7985BCPZ</td>
<td>AD7985BCPZ</td>
<td>AD7985BCPZ</td>
</tr>
<tr>
<td>U2</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ-R7</td>
</tr>
<tr>
<td>U3, U12</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5-R2</td>
</tr>
<tr>
<td>U4, U11, U19</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
</tr>
<tr>
<td>U5</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
</tr>
<tr>
<td>U6</td>
<td>FXL2TD245</td>
<td>FXL2TD245L10X</td>
<td>Digikey FXL2TD245L10XCT-ND</td>
</tr>
<tr>
<td>U7</td>
<td>M24C02-WMN6TP</td>
<td>M24C02-WMN6TP</td>
<td>Digikey 497-8552-1-ND</td>
</tr>
<tr>
<td>U8</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
</tr>
<tr>
<td>U9</td>
<td>FXL4TD245BQX</td>
<td>FXL4TD245BQX</td>
<td>Digikey FXL4TD245BQXCT-ND</td>
</tr>
<tr>
<td>U10, U18</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0-R7</td>
</tr>
<tr>
<td>U13</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ-R2</td>
</tr>
<tr>
<td>U14</td>
<td>AD8139ARDZ</td>
<td>AD8139ARDZ</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>U15, U16</td>
<td>ADA4899-1</td>
<td>ADA4899-1YRDZ</td>
<td>ADA4899-1YRDZ</td>
</tr>
<tr>
<td>U17</td>
<td>NC7S04</td>
<td>NC7S040M5</td>
<td>FEC 1013809</td>
</tr>
<tr>
<td>U20</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ-R7</td>
</tr>
<tr>
<td>X1, X2</td>
<td>MTHOLE-4MM</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
</tbody>
</table>
### Table 6. Analog Bill of Materials for EVAL-AD7944FMCZ

<table>
<thead>
<tr>
<th>Reference Designator</th>
<th>Part Description</th>
<th>Part Number</th>
<th>Stock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>+5V, +7V5, +12V, +12V_EXT, –3P0V, 1PT2V_REFIN, 2PT5V_REF, 2V5_EXT, 3P3VAUX, 5V_REF, BVDD_EXT, GND1 to GND3, +12V_SYS</td>
<td>Test point</td>
<td>20-313137</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>C1, C8, C11, C15, C25, C32, C33, C38, C39, C42, C44, C60, C62, C65</td>
<td>Capacitor</td>
<td>MCCA00255</td>
<td>FEC 1759122</td>
</tr>
<tr>
<td>C2, C3, C5, C7, C9, C10, C12, C20, C27, C28, C31, C35, C40, C43, C52, C54, C56 to C59, C61, C75</td>
<td>Capacitor</td>
<td>EMK212B7225KG-T</td>
<td>FEC 1683654</td>
</tr>
<tr>
<td>C4, C66, C77, C78</td>
<td>Capacitor</td>
<td>GRM188R60J475KE19D</td>
<td>FEC 1735527</td>
</tr>
<tr>
<td>C6, C19</td>
<td>Capacitor</td>
<td>GRM188R61A105KA61D</td>
<td>FEC 1828798</td>
</tr>
<tr>
<td>C17, C22, C24, C26</td>
<td>Capacitor</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>C13, C16, C18</td>
<td>Capacitor</td>
<td>GRM219R61C106KA73D</td>
<td>FEC 1845747</td>
</tr>
<tr>
<td>C14, C30, C34, C36, C63, C64, C69, C70</td>
<td>Capacitor</td>
<td>EMK212B7475KG-T</td>
<td>FEC 2112841</td>
</tr>
<tr>
<td>C21, C23</td>
<td>Capacitor, 0603</td>
<td>0805ZC106KAT2A</td>
<td>FEC 2094042</td>
</tr>
<tr>
<td>C29, C37, C41, C45 to C47, C50, C51, C53, C55, C67, C68, C72 to C74, C79</td>
<td>Capacitor</td>
<td>SML-LX06035UGW-TR</td>
<td>Digikey 67-1693-1-ND</td>
</tr>
<tr>
<td>C48, C49</td>
<td>Capacitor</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>C71, C76</td>
<td>Capacitor</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>D1</td>
<td>Diode, Schottky, 40 V, 0.2 A, 1PS79SB30</td>
<td>1PS79SB30</td>
<td>FEC 8734097</td>
</tr>
<tr>
<td>J1, J2</td>
<td>Connector, Power 3</td>
<td>5-1814400-1</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>J3</td>
<td>SMA</td>
<td>CTB5000/3</td>
<td>FEC 151790</td>
</tr>
<tr>
<td>J4, J5</td>
<td>Header, 06, SKT, RA</td>
<td>142-0701-851</td>
<td>Digikey J658-ND</td>
</tr>
<tr>
<td>J6</td>
<td>Connector, 7 position, header</td>
<td>ASP-134604-01</td>
<td>Samtec ASP-134604-01</td>
</tr>
<tr>
<td>J7</td>
<td>Connector, 7 position, header</td>
<td>SSW-107-05-G-S</td>
<td>FEC 1668499</td>
</tr>
<tr>
<td>J8</td>
<td>Connector, 6 position, header</td>
<td>TLW-106-05-G-S</td>
<td>Not Inserted</td>
</tr>
<tr>
<td>J9</td>
<td>Connector, Power 3</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>J10</td>
<td>3 W, solder link, 0603</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>JP1 to JP12, LK6 to LK9, LK11 to LK14, R1, R3, R4, R10</td>
<td>Jumper, 2 M20-9983646 &amp; M7566-05 (36 Pin Strip)</td>
<td>MC 0.063W 0603 1% 1K</td>
<td>FEC 9330380</td>
</tr>
<tr>
<td>L1, L3 to L5</td>
<td>Inductor, 22 µH, LPS4414-223MLB</td>
<td>LPS4414-223MLB</td>
<td>FEC 9522174</td>
</tr>
<tr>
<td>L2</td>
<td>Inductor</td>
<td>LH32CN1R0M33L</td>
<td>FEC 1022244 &amp; 150-411 (36 Pin Strip)</td>
</tr>
<tr>
<td>L6</td>
<td>Jumper, 2</td>
<td>M20-9993646 &amp; M7566-05</td>
<td>Do Not Insert</td>
</tr>
<tr>
<td>LK1, LK2, LK4, LK5, LK10</td>
<td>Jumper</td>
<td>M20-9990246</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>LK3</td>
<td>Resistor</td>
<td>MC0063W060313K3</td>
<td>FEC 9331026</td>
</tr>
<tr>
<td>R2, R9, R13, R26, R42 to R44, R47, R49 to R51, R54, R55, R56, R70, R72</td>
<td>Resistor</td>
<td>Not Applicable</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>R5</td>
<td>Resistor</td>
<td>MC0063W0603123K7</td>
<td>FEC 1170924</td>
</tr>
<tr>
<td>R6</td>
<td>Resistor</td>
<td>MC 0.1W 0805 0R</td>
<td>FEC 9333681</td>
</tr>
<tr>
<td>R7, R8, R14, R16, R17, R39, R45, R63</td>
<td>Resistor</td>
<td>MC0063W0603164K9</td>
<td>FEC 1170968</td>
</tr>
<tr>
<td>R11</td>
<td>Resistor</td>
<td>MC 0.063W 0603 1% 1K</td>
<td>FEC 933080</td>
</tr>
<tr>
<td>R12, R22</td>
<td>Resistor</td>
<td>MC0063W060313K3</td>
<td>FEC 933080</td>
</tr>
<tr>
<td>Reference Designator</td>
<td>Part Description</td>
<td>Part Number</td>
<td>Stock Code</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>R15, R20, R21, R23, R24, R27 to R29, R31 to R33, R35, R36, R46, R48, R59, R60, R64, R65, R67</td>
<td>Resistor, 0 Ω</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>R18</td>
<td>Resistor</td>
<td>CRCW08055K00FKTA</td>
<td>FEC 1835558</td>
</tr>
<tr>
<td>R19</td>
<td>Resistor</td>
<td>MCTC0525B1002T5E</td>
<td>FEC 1575900</td>
</tr>
<tr>
<td>R25, R30</td>
<td>Resistor</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>R34</td>
<td>Resistor</td>
<td>MC01W08051100R</td>
<td>FEC 9332375</td>
</tr>
<tr>
<td>R37, R38, R40, R41</td>
<td>Resistor</td>
<td>ERA6AEB5900V</td>
<td>FEC 1810481</td>
</tr>
<tr>
<td>R52, R53</td>
<td>Resistor</td>
<td>CPF0805810RE1</td>
<td>FEC 1697403</td>
</tr>
<tr>
<td>R57, R58</td>
<td>82 Ω, 0603, 1%, 0.063 W</td>
<td>MC0063W0603182R</td>
<td>FEC 9331590</td>
</tr>
<tr>
<td>R61</td>
<td>Resistor</td>
<td>MC0063W060311R0</td>
<td>FEC 2141505</td>
</tr>
<tr>
<td>R62</td>
<td>18 Ω, 0805, 1%, 0.1 W</td>
<td>MC01W0805118R</td>
<td>FEC 9332740</td>
</tr>
<tr>
<td>R66</td>
<td>Resistor</td>
<td>MC0063W060310K</td>
<td>FEC 9330399</td>
</tr>
<tr>
<td>R68</td>
<td>Resistor</td>
<td>CRCW0402000020ED</td>
<td>FEC 1469661</td>
</tr>
<tr>
<td>R69</td>
<td>Resistor</td>
<td>MC0063W0402111K</td>
<td>FEC 1358070</td>
</tr>
<tr>
<td>R71</td>
<td>Resistor</td>
<td>MC0063W0402111K5</td>
<td>FEC 1803142</td>
</tr>
<tr>
<td>U1</td>
<td>AD7944BCPZ</td>
<td>AD7944BCPZ</td>
<td>AD7944BCPZ</td>
</tr>
<tr>
<td>U2</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ</td>
<td>ADP2370ACPZ-R7</td>
</tr>
<tr>
<td>U3, U12</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5</td>
<td>ADM7160AUJZ-2.5-R2</td>
</tr>
<tr>
<td>U4, U11, U19</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
<td>AD8031ARZ</td>
</tr>
<tr>
<td>U5</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
<td>ADR4550BRZ</td>
</tr>
<tr>
<td>U6</td>
<td>FXL2TD245</td>
<td>FXL2TD245L10X</td>
<td>Digikey FXL2TD245L10XCT-ND</td>
</tr>
<tr>
<td>U7</td>
<td>M24C02-WMN6TP</td>
<td>M24C02-WMN6TP</td>
<td>Digikey 497-8552-1-ND</td>
</tr>
<tr>
<td>U8</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
<td>ADR4525BRZ</td>
</tr>
<tr>
<td>U9</td>
<td>FXL4TD245BQX</td>
<td>FXL4TD245BQX</td>
<td>Digikey FXL4TD245BQXCT-ND</td>
</tr>
<tr>
<td>U10, U18</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0</td>
<td>ADP7118ACPZN-5.0-R7</td>
</tr>
<tr>
<td>U13</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ</td>
<td>ADR3412ARJZ-R2</td>
</tr>
<tr>
<td>U14</td>
<td>AD8139ARDZ</td>
<td>AD8139ARDZ</td>
<td>Do Not Place</td>
</tr>
<tr>
<td>U15, U16</td>
<td>ADA4899-1</td>
<td>ADA4899-1YRDZ</td>
<td>ADA4899-1YRDZ</td>
</tr>
<tr>
<td>U17</td>
<td>NC7S04</td>
<td>NC7S04M5</td>
<td>FEC 1013809</td>
</tr>
<tr>
<td>U20</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ</td>
<td>ADP7182AUJZ-R7</td>
</tr>
<tr>
<td>X1, X2</td>
<td>MTHOLE-4MM</td>
<td>TBA</td>
<td>Do Not Place</td>
</tr>
</tbody>
</table>
NOTES

ESD Caution

ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. ADI hereby grants to Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return to ADI the Evaluation Board. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED "AS IS" AND ADI DISCLAIMS ANY WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2015 Analog Devices, Inc. All rights reserved. Trademarks and registered trademarks are the property of their respective owners.